pTools”

Template Manual - S7



Template Manual

Parallel Internet Limited pTools Software, Registered in Ireland No.6328117D 2



Template Manual

CMS Basic Intro

This information is the same as the introduction manual you would have received at the beginning of the
project. We’ve included it here in case you need a refresh of how the CMS is structured. There are also links to

some online CMS learning resources.

Locations (Site Structure)

Locations control the navigation on the site (sitemap, sidebar and nav bar, breadcrumbs, landing boxes etc.).
To create your sitemap simply create locations and/or sub-locations. Locations are where you assign a

template. You can also create hidden locations for folders like an internal media library for example.
The main steps to getting your sitemap and locations in place:

1. Go to Locations (the second tab, next to my desk)

Go to Home or a location in the site structure list (this will be the parent)

Click New (this will open the Basic Details of the new Location)

Give a Location Title (this is what appears in the navigation)

i A W N

. Click “Get Suggested” next to alternate title (this will automatically create the end URL so that the full path
is defined)

6. Click Submit (the blue button at the bottom, this will publish the location)

Mydesk  Locations Search Users Groups Workilow Tools pTools Admin @ ﬁ__‘

i New B Delete i Copy r sublocations
i E—
5] Home| Tide Priority | Template FullPath
L@ AboutUs
| "L About Community Care Home 0 Templates/General/HomePage Master i
i1 Our Services Sublocations - Title Pricrity Template Fullpath a
2 B Wnere We Are
B How to Access Services About Us 0 Templates/General/Columns2.Mas. fabout.us/
Contact Us
e bory Contact Us 0 Templates/GeneraliHomePage.Ma... feontactus/
Sitemap ImageLibrary f] Templates/GeneraliHomePageMa... fimagelibrary!
20 Years Celebration
System Seven Sitemap 0 Templates/General/HomePage.Ma... isitemap/ 8

Search
Privacy Polkcy Basic detalls [ ]
© I Accessibility 4

Title: Home
Atermate e Home cersuggesiea | [S)
Full path: !

Short URL: /57 ptools.net/ ZCKQED

Summary:

Summary image: | Select

Type: Standard location d

Parent’s setting;
Page Layout: v

OrderingPagesFiles) Publish Date W | | Descending -

Parent's setting

Priofity: Main Menu -
Primary page:
S Select
Comments enabled: ( =
Content type for pages: =
Content type for files: et
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This is how you create the locations and sitemap of your site. To create sublocations or the “next levels” down
simply click on the location of your choice and repeat the process, the location highlighted will be the parent of
the new location. E.g. to create a “2018 Events” sub location of “Calendar of Events” you should navigate to
Locations, then “Calendar of Events” in the list, then click new and repeat the process above until you submit.
When you refresh the CMS the new location will appear. Locations can also be moved, deleted and ordered via
the buttons next to “New”.

Pages

Pages are what hold the actual content (headings, paragraphs, embedded images etc. as seen in the 2-column
template). Some templates can cater for multiple pages in a single location like News or Bio templates. Others
may not require pages at all like Landing and Homepage templates. You can refer to the template manual

(created and sent to you during UAT) to see the selection of templates available for your site.

The main steps to getting your pages in place:

7. Go to Pages (the third tab, next to locations)

8. Goto “Home” (this is the root location)

9. Click New (this will open the Basic Details of the new Location)
10. Give a Location Title (this is what appears in the navigation)

11. Click “Get Suggested” next to alternate title (this will automatically create the end url so that the full path
is defined)

12. Click Submit (the blue button at the bottom, this will publish the location)

I ydesk  Locations Pag!s Search Users Groups Workflow Tools pTools Admin O I:
pTd

jNew JBjecit B§oelete Byunpublish ByMove McCopy [ History ~

Site Structure 4

5% Home Fier: T4 InWorkflow 4 Published Bl Unpublished M Draft Il Deleted BN nerbyname Q|
=3 " About Us]

b A e Title Publish Date Status Remark SEO
1 Our Services
| -Bm Where We Are B B Aooutus 03/04/2019 Published x

| How to Access Services
E-Bm Contact Us
M ImageLibrary
£ Sitemap
£ 20 Years Celebration
B System Seven

Pages -

E-im Privacy Policy
= Accessibility

Title: | Test pal

Alternate title: | Get suggested 1 1
Full path: Jabout-us/preview.htm| View Website

Shert URL: PBage needs to be saved to generate short url

Summary:

Page thumbnail: | a =
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Content

Pages are used to store the content to a site. Images and files can be uploaded to locations and then related or
embedded to these pages.

To add content to a page:

13. Go to Pages

14. Navigate to the location in the site structure list where the page is

15. Find the page in the Pages list.

16. When you click on the page it will open the Basic Details of the Page.

17. Navigate to the Content tab (the next tab to Basic Details).

18. Click the Edit button (Next to New).

19. Input content (the editor will allow various content such as bullet points, embedded videos and images,
videos, internal and external links etc.)

20. Click the Save button (the default status is to Publish)

proots admin @) [

Mydesk Locations | Pages i Users  Groups Workflow Tools
pTools”

% New  PBifdit B Delete 13 sh  BjMove @ Copy [ History ~

@ Fiter: 4 InWorldlow 4 Published [l Unpublished [l Draft [l Deleted
 Home A 4 Publhed I Unpubl u u RN fiter by name Q
L About Us |
-8 Our Services
14 - Where We Are o] 00/04/2019 Published
- How to Access Services
£ Contact Us

™ imageLibrary
£ Sitemap
1 20 Years Celebration

[} System Seven 1 7

I Privacy Policy 6
- Accessibility dit~ Insert~ View~ Format~ |Accordien ~

h Paragraph - Formats -

Wk L @ e m M oEovE N o X

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod temper incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud
exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat. Duis aute irure dolor in reprehenderit in voluptate velit esse cillum dolore eu fugiat nulla pariatur.
Excepteur sint occaecat cupidatat non proident, sunt in culpa qui officia deserunt mollit anim id est labarum.

Sed ut perspiciatis u| 1 9 iste natus error sit voluptatem accusantium doloremgue laudantium, totam rem aperiam, eaque iosa quae ab illo inventore veritatis et
quasi architecto bes cta sunt explicabo. Nemo enim ipsam voluptatem quia voluptas sit aspernatur aut odit aut fugit, sed quia consequuntur magni dolores eos

seiunt.

dunt ut IRoR et tolore magnam a q uptate enim ad minima venism, quis nostrum ullam gorpori pit laboriosam,
nisi ut aliquid ex ea commodi 7 Quis autem vel gum iure 1 it qui in ea voluptate velit esse quam nihil molestiae consequatur, vel illum qui dolorem
eum fugiat que voluptas nulla pariatur?

P Words: 198

- 20
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Files

You can do a batch upload of files. Hover over the Files tab (next to Pages) and select “Batch Upload”. You will
be asked which location to put the files before uploading by drag and drop. To view files in each location go to

the files tab and then the location in the site structure list.

Files like images can then be embedded into the content of pages. Files like documents and pdfs can be added

to a page using the ‘Related’ tab or the ‘Internal links’ icon in the content editor.

My desk Locations Pages | Files Search Users Groups Workflow Tools

pTools”

Batch File Upload

* First select the location to upload the file to
* A batch upload control will appear, use this to upload files

The location to upload the files to: Mot selected

Select the location >

Select the itemns fram the tree

2 ome oo

(-8 About Us
M= About Community C
W Our Services
.- Where We Are
MW How to Access Servic
F;| B Contact Us
R imageLibrary
F;l I Sitemap
5 20 Years Celebration
G- System Seven
- Search
G- Privacy Policy
G- Accessibility

Parallel Internet Limited pTools Software, Registered in Ireland No.6328117D



Template Manual

Mydesk Locations Pages | Files Search Users Groups Workflow Tools
pTools”

Batch File Upload

* First select the location to upload the file to
= A batch upload control will appear, use this to upload files

The location to upload the files to: fimagelibrary/

Upload a file

Coastjog Forest.jog
79.BkE 160.1kB
Edit name | | Edit name
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Create a New User

Go to ‘Users’ on the navigation bar and select ‘New’ on the left-hand side under the navigation. Fill in

the required fields in basic details and hit ‘Submit’.

Mydesk Locations Pages Files Search Users Groups Workflow Tools pTools Admin @

pTools”
B New M Delete

Filters Other Criteria

Email address:
Select type: With admin section access v

Phone
Select type: ‘ Any group v ‘ e

e | |

e | |

Mydesk Locations Pages Files Search | Users
pTools™

M New B Delete

[FETTEEN Group membership | Group membership recursive  Warkflow rights

Firse Name: ‘ Jee
Last Name: ‘ Bloges
Login Narme: ‘ Joe

Retype Password: ‘

[ |

Email ‘ joe.loggs@mail.com
Phone: ‘ 014568967
Profile Image:
Photo will
display here

Upload a file

User's account is enabled:

User has access to CMS.
admin:

Force user to review details:

it il

Farce user to change
password:

Create date: 03/04/2019 15:08

User last reviewed details on: 31202335

Subrmit
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Images & Web Optimisation

Optimising images for the web means compressing or reducing the file size in order to reduce page load. All
images must be optimised before uploading to the CMS and used on the site. Most images are JPEG format.
However, logos or images with text such as infographics should be .PNG.

Software like Photoshop or any image manipulation software should allow you to save images at reduced file
sizes, sometimes as a percentage or as a level out of 10 or 12. There are also numerous free online image
compression sites that will reduce the file size.

Large image files will cause usability issues, especially on image-heavy pages such as the Homepage and other
template pages. To avoid long page loads make sure big hero images and others are as small as possible in file
size. Images on 1 or 2 Column templates should also be optimised and reduced to ideally less than 100kb and

also less than 1100px wide (1 column) or 870px (2 column). The more images used on a page the more the file

sizes will add up and reduce page load. If the total page image file size is over 700-900kb there will be a

A}

noticable page load time.

870px

< 1100px

Y

Original image (no optimisation). File size: 605kb.

Optimised image (saved with a quality of level 2 in Photoshop). File size: 45kb.

The images are almost indistinguishable but the file size is massively reduced.
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How much to compress depends on the image quality and your judgement. Compress more until the image
starts to visibly lose quality and become too pixilated. As long as the image quality looks satisfactory keep
reducing file size until it doesn’t, before that point is reached save the image and it will be web optimised.
Resizing down the dimensions to recommended levels is a quick way to reduce file size. You can also have the

original full-sized large images as a related file instead.

Full Screen or Large Images (Hero Images)

Hero images are the large, usually full screen images that are at the top of homepages for example. They are
used to grab the users’ attention and need to be high quality images before they are optimised. Main
Carousel/Hero images should be jpeg and be no less than 1600px width if possible. This is not to say that the
image cannot have larger dimensions as long as the file size is ideally below 300kb however the CMS will resize
and centre the image to fit the required space. Square images may not work well as they will stretch when
viewed on desktop or widescreen monitors. Check the carousel/hero image height in the template manual to

see your recommended width and height.

Images can be shrunk to reduce file size but be sure to keep the aspect ratio locked so that the image does not

stretch or distort when resizing. Images should also be cropped to get the desired dimensions.

4456px

.'ﬁ

6000px

Y

A

Original image. Dimensions : 6000 x 4456 (8,000kb)

<% 1900px >

Dimensions shrunk and then cropped. Dimensions: 1900 x 600 (344kb - optimised)

(The particular template manual for the above hero image specified a 600px height.)
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Recycle Bin

The Recycle Bin tool can be found by clicking the pTools icon in the top left corner of the CMS, and
navigating to the bottom of the pop-up menu.

Mydesk Locations Pages Files Search Users Groups Workflow Tools
pTools’

CMS Admin

Forms

N

URL Rewriter

o

Recycle Bin

8

Landing Page Builder

The Recycle Bin can be used to recover any deleted items, while detailing the time, date and user associated
with the deleted item.

Mydesk Locations Pages Files Search Users Groups Workflow Tools

pTools™

Deleted items . Search by Keyword

Name = FullPath = Type = Deleted = Deleted By <| No. Subitems =

CMS 7 Tutorials JCMS-7-Tutorials/ Location 08/11/201909:38  Fitzpatrick Aisling 3
FAQs /CMS-7-Tutorials/FAQs/ Location 08/11/2019 09:32 Fitzpatrick Aisling 0

How to edit a report /CMS-7-Tutorials/Tools/Forms-Tool/How-to-edit-a-report.html Document  23/10/2019 11:23 Whyte Cian 0 @
How to use the forms tool ~ /CMS-7-Tutorials/Tools/Forms-Tool/How-to-use-the-forms-tool.html Document  23/10/2019 11:23 Whyte Cian 0

Name of the item that was deleted.

Type of item that was deleted (i.e. Page, Location, File, etc.)

Time and date the item was deleted.

User responsible for the deleted item.

i A WN =

. Torestore the item to where it was originally, select ‘View details’ - ‘Restore’.
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Forms Tool

To build a new form, go to ‘Tools’ in the navigation bar and select ‘pTools Forms Application’. This will bring
you to the Forms Tool Dashboard, where you can build a new form, or edit an existing one. To build a new
form, select ‘Create Form'.

Mydesk Locations Pages Files Search Users Groups Workflow Tools

pTools™

Dashboard
- A Text Box Parameters

Field Label:

>

Builder

Data Sources

Validation:
1
4
Form Builder @
n Reports

<

<]

Show Advanced Options

©c D@

Add

1. Form Details — Edit the title, description & some more advanced features of your form.

2. User Rights - Edit the form owners and who has access to the form’s reports.

3. Form Builder — Edit the form’s content. Navigate around different types of answer options, such as plain
text box, checkboxes, upload a file.

4. Form Builder — Text validation can be used to restrict answers to a certain format (e.g. phone numbers
must be in number format, etc.)

5. Preview — See what your form will look like on your site.

6. Reports — View and filter the form’s responses. To export responses to an Excel spreadsheet, select

‘Export to Excel’.

Parallel Internet Limited pTools Software, Registered in Ireland No.6328117D 12
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Forms Tool (Cont’d)

Once you have finished building your form, go to ‘Pages’ in the navigation bar. Select the page which you
would like to populate with the form. In the ‘Basic Details’ tab, scroll down to ‘Page Tools' and select your

form. Don't forget to save your changes at the bottom of the page.

Mydesk Locations = Pages Files Search Users Groups Workflow Tools
pTools”
& New Byredit B§Delete B unpublish Mg Move Wcopy [ History ~

display here

Hidden: .:I

Page Layout:

Dates

Page Tools

Map Coordinates: | Latitude | | Longitude | ‘ Select ‘
Extra Map Markers: No markers defined.

Forms: Webinar Sign Up “~

Landing Page: I couldn't find the information |

was looking for

Poll:
Webinar Sign Up
Comments enabled:
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Landing Page Builder

My desk = Locations Pages Files Search Users Groups Workflow

pTools’
%new Bypelete MyMove [Bicopy 1 Order sublocations

The Landing Page Builder can be found by

HH in
clicking the pTools icon in the top left corner mm VS

of the CMS, and navigating to the bottom of & WDE |
the pop-up menu.

[ ] Q

pages Files Search

é Forms
, URL Rewriter

I_‘?'_. Recycle Bin

[M Landing Page Builder

Mydesk Locations Pages Files Search Users Groups Workflow Tools Cian

pTools™
List of Landing Pages Step 3 Layout & Name Select a Form Select ltem
Builder
Didn't find what you were looking
/Need-more-help/question-mark- for? Let us know!
1872665_1920.jpg
Please leave a detailed description of the information
you were looking for. *
Add Content
Enter Text Here
“ @ Paagraph ~ B [
B- E=E = E
= L o A
Other than what we missed, did you find the pTools
Extranet helpful? *
O Yes
O No
1. Decide the layout and title of your new landing page template.
2. Select your pre-built form that you would like to use in your template.
3. Insert text & images to the template.
4

. Edit the text on the submission button (e.g. ‘Sign Up’) and select ‘Save Landing Page Template’.
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More Tools

Collaboration Tool Select the collaboration members X

To collaborate with other users on a page, go to ‘Pages’  Select the items from the Lree

in the navigation tab and select the page you would like =3~ Jusers]

€ () admin admin

to collaborate on.
€ (¥ Fitzpatrick Aisling User filter
Select the Users/Groups you would like to collaborate i € () Whyte Cian Only admin section users: (@@=
#-Im Groups
with and select ‘Next step...". ‘ Lastname contains ‘
Finally, select the date the page should be completed by ‘ Email contains ‘
and add any relevant comments.
| Reset filter | | Reload users |
URL Rewriter
Under ‘Tools' in the navigation tab, select ‘URL New Redirect
Rewriter'. Select ‘Add URL', which will bring you to
URL Manager.
Type:
1. Set Type'to ‘Redirect URL'. Redirect URL -
2. Then, in the ‘From URL' textbox, insert the URL
you would like to be redirected from, e.g. Erom Ur
‘www.ptools.com/Shorter-URL'.
3. Inthe ‘To URL' textbox, insert the URL you
would like to be redirected to, e.g. To Url
‘www.ptools.com/big-long-url-that-takes-long-
to-type'. Match type:
Exact Match v
Redirect type:
Permanent (301) v

=
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Frequently Asked Questions

How do | define popular content (Banners and Quick links)?

From the CMS top menu, select the Tools tab. From the dropdown menu select Banners or Quick links.

Mydesk Locations Pages Files Search Users Groups Workflow = Tools
pTools”

% New By Delete  {f§ Sort Banners

Quicklink Items Contaxt groups
Position Name T Text Feed reader
Call To Action Quick links
Carousel Blog comments

Polls

Config files

pTools Forms Application
Content Types

URL Rewriter

Page Builder

Each template could have its own Quick Links or Banners. In the example above, when a quick link is selected
in the left side-menu, a quick link Items menu is displayed (the white space). This menu lists each iteration
(item) of that quick link type. When you open a quick link item it will open its basic details. You can also create

a new quick link item using the “New” button on the top left. This same process goes for banners, see below.

How do | update banners?

From the CMS top menu, select the Tools tab. From the dropdown menu select Banners.

Mydesk Locations Pages Files Search Users Groups Workflow —Tools

pTools™

% New J§ Delete Banners

Banner List 4
A

Context groups
Banner ltems gradp

Position Name Alternate text Source Eeadresdy
Contact Us Quick links
Mydesk Locations Pages Files Sed
iTools”
Cookie - Header Blog comments P N New B Delete
Site logo - Header Polls )
Banner List 4 Banner ltems

Config files Position Name 7 Alternate text

Contact Us

pTools Forms Application

Cookie - Header

Content Types

Site logo - Header

URL Rewriter

Page Builder
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The side-menu lists selection of the items contained in the banner. When a user selects an item in the Banner
Items list, they are presented with a text or image editor interface. This depends on the banner type chosen
for that banner (see Banner Type). The template manual will tell you which type of banner to choose and what

to edit or create to see the result on the output.

Mydesk Locations Pages Fles Search Users Groups Workflow | Tools

pTools”

MiNew % Delete

Banner List Banner ltems

Pasition Name

-~
i 1

<ahref="r"><imgsre=.. | Text

Contact Us

Cookie - Header

Basic details

Banrer type:

-]

Hidder: [ =
Apply o fullpaths: m— = meeyoseee | T
¥ ; )
v
Text definition: Edit~ Insert~ View~ Format Table~w
Paragrash - Fomasw B F = E = =
= E & ox ¥
mW s P @ e mommov £ oo 3
FovaredbaTraie
‘Words: 0,

Colour's and spacing abowve may nat represent website colour scheme

» Freview m

How do | find a page?
At the top of the window there is a menu from which you can navigate through the different sections of the
CMS. To find a page in the CMS, first move the mouse cursor up to 'Search' and a menu will open. Select the

option ‘Pages’.

Mydesk Locations Pages Files Search Users Groups Workflow Tools
pTools™

aNew MyEdit MByDelete By Pages ByMove MCopy [ History ~

Files
My Desk Options Pages inw

My Tasks o'l Filter: T4 InWorkflow i Published [l Unpublished [l Draft [l Deleted

Pages waiting in workflow

Files waiting in workflow
My Details -

Status -
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You should now see the 'Search' section of the CMS.

We can see a form with several 'text fields' has appeared on the left-hand side of the screen. In order to
perform a search, we must fill in these fields and left-click on the 'Search' button below. You do not need to fill

in every field on the search form, but you will receive a closer result by filling in more parameters.

Now that this form is completed, left click on the button at the bottom of the form, entitled 'Search'.

The CMS will now begin searching for pages using the parameters you've entered on the search form. Once
complete, it will display the files in a list on the centre of the page. Simply select a file from the list to begin
editing.

Mydesk Locations Pages Files = Search Users Groups Workflow Tools

pToals Admin (@)

pTools

BnNew Jiedit J§Delete J§ Unpublish

Pages - Search Criteria

& Move

Kooy B

Publish Date Range

Title: I From: ‘ B 7o e} |
Type: Keyword can be anywhere v | Expiry Date Range

Full path: | From: ‘ B To rc) |
Summary: | Other Criteria

Content: I Author:

Location: | Keywords:

Include sub locations: .:' Select

How do | create a Bookmark or Anchor?

Hyperlinks can be used to create bookmarks and anchors inside a CMS document (page). Clicking on a
bookmark link will focus the user onto the bookmark or anchor. This is particularly useful if there is a lot of
content in a single CMS document as it allows users to skip to sections they are interested in quickly. In general
the best strategy is to create a list of numbered or bullet point list at the top of the page, then create anchors

over each heading within the page that should coincide with the list. Each list item can then be hyperlinked to

the corresponding heading. (ie Intro, Middle Section, Conclusion etc.)

Basic details Content Metadata Social Related Shortcuts
Edit~ Insert~ \View~ Format~ Table~ Accordion~

“ @  Paragraph ~ Formats~ Insert link x £
W kB |&£|€@ & @ BB

url ‘l

Text to display

Target None -
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To create a bookmark link, highlight the text you want to turn into an anchor and select the anchor icon in the

editor.

Insert~ View~ Format~ Table~ Accordion ~

Paragraph ~ Formats~ B [ 1= =
E & @ 6 @ & @ Vv BE O[] o

You will then be able to name the anchor so that you can recognise it later when you hyperlink text to it.

RA
W

Caontent Metadata SEO Social Related Shortcuts Waorkflg

View > Format~ Table~ Accordion =

agraph <~ Formats~ B 7 2 = E E E E ZE E 66 x X
You
¢ ¢ m B ¥ Anchor X

X -

After you click OK the anchor will be created. You can then go to any piece of text in the document (page) and
insert a hyperlink, when you open the insert link the option to select an existing anchor will also display, you
can use the dropdown to find the name you had created for that anchor. When the user clicks on that piece of

text they will be taken to the anchor you have created.

Some example of using the anchors could be an anchor on the first main heading of the page and a hyperlink
to it from a piece of text at the bottom “Back to Top” for very long content pages. Other uses include
replicating each heading in the content with its own text at the top of the page, to act like a table of contents

that link to each section.

How do | upload or embed videos?

To upload a video in the CMS, click on the YouTube icon in the icon menu in the content area. This will open up
a popup screen. On the popup screen paste the YouTube URL into the field labelled YouTube page URL, select

what size resolution you want the video to be and click insert.
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Insert/edit media

General Embed Advanced

Source

Dimensions Constrain proportions

Cancel

| can’t find my page

Browse to the location you published to or use the search page function.

Mydesk Locations Pages Files Search Usars Groups Workflow ools pTools Admin {";

pTools
% New ByEdit JB§Delete BjuUnpublish ByMove BCopy [} History

(=88] Home | Fiter: If InWorkflow 4 Published [l Unpublished [l Draft [l Deleted iter [ — Q

Title Publish Date Status Remark SEO

B b My new page 09/04/2013 Published x

If you can’t see your page make sure that the filter items have been checked (the tick boxes above).

=  Workflow — Shows all pages that are in the Workflow

= Published — Shows all pages that are Published on the website

=  Unpublished — Shows all pages that are Unpublished in the CMS
=  Draft — Shows all pages that are saved to Draft

=  Deleted — Shows all pages that are marked as Deleted in the CMS
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pTools and WAI

Use the clearest and simplest language appropriate for a site's content. Using clear and simple language

promotes effective communication.

Provide a text equivalent for every non-text element. Computers cannot interpret images/videos and present
them in a meaningful alternate format; alternative text gives the computer something to present to the user.
Always use the “Get Suggested” button to create the Alternate title (this is the URI).

Basic details Metadata mm Related Shortcuts Workflow history Additional Data

Title: | My new page |

Alternate title: | My-new-page | | Get suggested ‘
Full path: /my-new-page.html
Short URL: http://s7.ptools.net/ISOFOMU

Summary:

Summary of my new page

Page thumbnail: ‘ | | -
Phg will | Remove thumbnail
display here
Hidden: .:n
Page Layout: | — |

Page Tools

Page Info

For data tables, identify row and column headers.

For data tables that have two or more logical levels of row or column headers, use mark-up to associate data

cells and header cells.

Do not use the same link phrase more than once when the link points to
different URLs.

If more than one link on a page shares the same link text, all those links should point to the same resource.

Such consistency will help page design as well as accessibility.

When the same link phrase re-occurs, there is an implication that the links point to the same place. If they do

not, users may be surprised and disoriented.

Create link phrases that make sense when read out of context.

Authors should not use phrases like "click here" as link text; this requires a user browsing the page with a
screen reader to step through each link and read the surrounding text to determine the purpose of the link,
instead hyperlink the actual description or title of the content, eg “Read More about the pTools Template

Manual”. This will also help with SEO as well as usability and accessibility.
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Nest headings properly.

Increment heading levels correctly; for example, H1 followed by H2, rather than H1 followed by H3. Consider
headings as analogous to an outline. The outline should not appear as:

I. Heading 1
1. Heading 3
A. Heading 2

Some users skim through a document by navigating its headings (the H1, H2, H3, H4, H5, and H6 elements).
Some access aids extract the headings to create an outline of the page, allowing users to get an overview and
jump quickly to a desired part. Incorrect nesting of headings will result in an incorrect outline structure which
may disorient users.

How do | use a shortcut?

By utilizing ‘Shortcuts’ you can have your content auto update where you might have other instances of it.

Basic details Content Metadata m Related Shortcuts Workflow history m Tasks Additional Data

Name FullPath

Add | ‘ Remove

|& Compare to previous | |Ei Preview ‘ Save details - = Save

What are ‘Internal links’?
Internal links are used for links within the CMS. The link is attached to the object rather than the url. If the

object is moved to another location the link will stay intact as it auto updates.

Basic details Cont

Edit Insert~ View~ |

Paragraph v
B & € 66 |

Intermal links
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